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Chicago Style (CMS) Reference Guide BLRGO

CMS, which stands for Chicago Manual of Style, has two different citation systems: the Notes-Bibliography
System (NB), which is used in the arts and humanities, and the Author-Date System (AD), which is used in
physical, natural, and social sciences. The NB system uses a footnote/endnote citation style that includes a
superscript (raised) number in the text to direct readers to a footnote at the bottom of the page or to an
endnote at the end of the paper. The AD system uses parenthetical citations similar to APA Style. You should
check with your instructor to determine which system to use.

Please note that this guide is in accordance with the 17th edition of CMS.

General Document Guidelines

e The page margins should be one inch on all sides.
e Use 12 point Times New Roman, Courier, or another readable font.

o All pages should be double spaced, including block quotes, notes,
bibliographic entries, table titles, and figure captions.

o All pages, except for the title page, should be numbered in the upper
right hand corner. The page after the title page should be numbered as
number 1.

e The title page should have the title towards the top third of the page; the e
writer’s name, the course information, and the date should be towards e e
the bottom third of the page.

The Th j i
Bibliography e Three Major Sections

CMS papers have three basic sections:

o The title page contains your identifying information (paper
Main Body title, name, class/professor name, and date) centered and
double spaced.

e The main body of the paper is where you develop your
Title pqge ideas using citations and data. It can be divided up by
headings.

o The bibliography page provides a comprehensive list of the
sources used. This should start on its own page and should
be labeled “Bibliography” for the Notes and Bibliography
system, and “References” for the Author-Date system.

= You should check with your instructor to determine
which system to use.

This reference guide primarily focuses on the
Notes-Bibliography system, but does provide general
information on the Author-Date system
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Title Page

The title page has a different header and set up than 9] Ditterent First Page 5 Head
[T Different Odd & Even Pages | [} Foot,

the reSt Of the paper‘ Moving “Networks” into the Composition Classroom Show Document Text j Inserf

Options

Design

Different First Page

Here are the steps to assist you in this process:

Specify a unique header and footer
for the first page of the document.

1. Double click the top of the page to view your @ Press L for more he.
header options. Go to the top menu bar and click Step 1: Different first page
the box that says “Different First Page.” s Clomens P—— P

English 626: T Rhetoric, C:

2. Select “Page Number” from the menu bar and then March7,2010 Number forna. | ERCA,
select “Format Page numbers.” In the menu box D‘(;:"‘T ]hmf‘ R
that appears, click the option “Start at” and type the Use separator: - Pypen
number zero (0). Click “OK” to save these changes. —_— o

3. Click the “Close Header and Footer” option to go to your title page. About 1/3 of gf;:';:“:mpmumm
the page down, centered, you should have the title of your paper using concel
headline-style capitalization. About 2/3 of the page down, centered, you should Step 2: Page number format
have your name, your class or professor information, and the date. Make sure to H o -
use a CMS recommended font. fe tome P oo

4. To insert a new page, go to the “Insert” tab on your Word menu and select the B OO= B L
“Page Break” option. This will create the page where you can begin to type your Cover Blark Y| Tobe | Pict
essay. You can also use this tool to insert a new page for your bibliography section. T

Step 4: Create a new page

j j A J 4 [ Signature tine -
NG B Date &:Time

er| Page || Tet Quick Werdart Diop

bs Box~ Parts~ - Cap- '8 Objedt ~

5. Double click the top of the second page and click on the “Page Number” icon on
the menu bar. Select “Top of Page” and then “Plain Number 3” in the option menu
to ensure your page number will be on the upper right corner. You should now see
a “1” appear on your second page. Scroll up to see the header of your title page; if
you see a page number on the title page, go back to step one and ensure the

“Different First Page” box has a check mark to correct this error.

» | simple
» | Plain Number 1

Plain Number 3

I

Step 5: Insert page numbers

Level Headings

Headings help organize your writing and give it a hierarchical organization. All subsequent level headings
follow the format below:

Level # How it’s formatted
1 Centered, bold or italics, Title Case, On Its Own Line
2 Centered, Standard Type, Title Case, On Its Own Line
3 Left-justified, bold or italics, Title Case, On Its Own Line
4 Left-justified, standard type, sentence case, on its own line
5 Left-justified, bold or italics, sentence case, NOT on its own line, ending with
a period.
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The Notes-Bibliography (NB) system of the Chicago Manual of Style makes use of footnotes and endnotes to
cite information. For this system, you will document your sources in two places: footnotes/endnotes and your
bibliography at the end of your essay.

The Notes-Bibliography System

FOOtHOteS app ear at th € b ottom Of € aCh p age Lorem ipsum dolor sit amet, consectetqv—a{jipiscing elit. Quisque sapien ante,
and are sometimes Separated from the text by an placerat sagittis interdum a, feugiat nec sern." Sed tempor dui libero, dictum varius nibh
. . blandit nec. Vestibulum vel augue hendrerit, pellentesque eros semper, volutpat arcu.
optional short line. 5 S o e g o boosn s g
. . . . onec ornare us nibh vel suscipit. Sed sit amet mauris quis nisl euismo
(] They must be listed in the order in which the tempus et eget ton@vamus nulla urna, placerat quis tincidunt nec, efficitur ac orci.
superscript numbers appear in the text, and | Quisaue lobortis et rpis non eleifend.
must appear on the same page in which the

R . P 1.This is an example of where footnotes are placed.
source 1S Clted. P 2. Footnotes provide additional information about a sentence and direct readers to outside

e The first line is indented with Subsequent sources, either to cite an idea or to suggest additional reading about a topic.
lines flushed to the left margin of the page.

o Footnotes are not limited to citations for sources used as evidence, but may also include
commentary and further explanations of concepts discussed within the text.

e Footnotes are usually single-spaced for class assignments, but double-spaced for dissertations/
publications. Check with your professor to ensure the correct spacing is used for your piece.

Endnotes follow the same formatting guidelines as footnotes with the exception that they
appear at the end of the paper under the centered heading “Notes” instead of at the end of each page.
Similar to footnotes, endnotes are organized by citation number, in the same order in which they appeared
in the text. Endnotes may also provide commentary or additional information on concepts being discussed.

Inserting Footnotes

1. Click where you want to add a citation or commentary. This is EW  VIEW  Tell me what you want to do
typically at the end of the sentence but can also occur within the ;
sentence itself. D
2. Select the “References” tab on your Microsoft Word window. raer s hee
3. Choose the “Insert Footnote” icon. This will insert a superscript
within your text as well as at the bottom of your page.
4. Go to the bottom of your page, where the footnote appeared, and type/insert your citation. You can find
information on how to format citations within footnotes in the next few pages of this document.

ﬁ‘]lnsert Endnote

Header & Footer Footnotes

Inserting Endnotes

1. Click where you want to add a citation or commentary. This is [EW  VIEW  Tell me what you want to do
typically at the end of the sentence but can also occur within the D
#

1 ﬁ'} Inse rthEnante

sentence itself. AB Ly
2. Select the “References” tab on your Microsoft Word window. feader&  Page lInsert
) - . . R Footer MNumbers~ Footnote
3. Choose the “Insert Endnote” icon. This will insert a superscript eacier & Footer S

within your text as well as a superscript at the end of your piece.

Note that this section will continue to shift as you write your piece, even if you move on to a new page.
4. Go to the end of your piece, where the footnote appeared, and type/insert your citation. You can find

information on how to format citations within footnotes in the next few pages of this document.
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When Citing the Same Source More Than Once

The first time you are citing a source, CMS requires the inclusion of all important and relevant information
regarding the source. This includes (but is not limited to) the first and last name of the author, name of article
or chapter, name of journal or book, year of publication, and page(s) being cited. Subsequent citations of a
source need only include a short form with relevant information. Below are two examples of subsequent
citations of a previously cited source:

Number. Lastname, “Title of Article,” page(s) being cited.
Number. Lastname, Title of Book or Journal,” page(s) being cited.

Block Quotes

A typical quotation is enclosed in quotation marks. When the quote is five lines or longer, you should format
it as a block quote. A block quote should:
e Begin on its own line, all lines in the quote
indented over .5 from the left margin

concern with her methods in his book The Cycladic Spirit. He writes,

. . These queries are certainly not intended to call into doubt the value of many of

® Omlt quOtatlon marks Getz-Preziosi’s observations nor to question the very great importance of the
o : : issues that she has raised...But the majority of the claims rest on highly subjective

* In(ﬂude the In-text citation Should come aﬂer perceptions and, once again, the dearth of well-documented contexts for these
the ending punctuation, not before 1t pieces has deprived us of much of the information that we would need for a more

adequate interpretation.’

o Skip a line before and after the block quote
e Bessingle-spaced

It’s clear that these archaeologists are of the mind that without context, these pieces are

Tables and Figures

Tables

A table often presents numerical information in grid format. In CMS, tables must be included immediately
following the paragraph in which they are referenced. When a table is mentioned in the text, refer to it by its
number (ex. “Table 1”) instead of saying “this table” or “the table below.”

Format your tables as simply as possible, without including bold or italicized text unless needed for emphasis.
A label should appear before the table, followed by a colon and a short, descriptive title. For example:

Table 1: Mosquito populations in the Chicago River from 2015-2018

Tables and their labels should be flushed to the left margin. Below the table, you should include the word
“Source:” or “Sources:” in italics followed by your citation of where the information in the table was retrieved
from. The citation should be in footnote/endnote format.

Source: Firstname Lastname, “Title of Article,” Journal volume, no. issue (year): page[s] cited, URL/doi.

Figures
Including figures in your piece is similar to including tables, with two exceptions:
1. Include the figure immediately after you reference it in the text
2. All information on the figure, including its number (“Figure 1”) and title, should appear on the line
below the figure.
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Below you can find information on how to cite the most common types of sources in accordance with CMS.
Please note that the word “Superscript” at the beginning of footnote/endnote examples refers to the
superscript that would be assigned to that particular source. Please note that footnotes/endnotes should
include an indented first line followed by un-indented subsequent lines, while a hanging
indent is used for each entry in the bibliography.

Citations in Footnotes/Endnotes and the Bibliography

Book, single author

Footnote/Endnote Superscript. Firstname Lastname, Title of Book in Italics (City: Publisher, year),
Format: page[s] cited or chapter number [if no page numbers].
= Example: = 1. Lewis M. Doe, CMS Reference Guide (Romeoville: LUWC Press, 2018), 19.

Bibliography Format: | Lastname, Firstname. Title of Book. City: Publisher, year. URL [incorporate DOI
when possible or state ebook type, for example Kindle].

= Example: = Doe, Lewis M. CMS Reference Guide. Romeoville: LUWC Press, 2018.

Book, two or three authors or editors

Footnote/Endnote Superscript. Firstname Lastname [first author], Firstname Lastname [second
Format: author], and Firstname Lastname [last author], eds [if editors]. Title of Book in
Italics, edition. (City: Publisher, year), page[s] cited.

= Example: = 2. Lewis M. Doe, Melissa Lonero, and Taylor French, eds., CMS Reference Guide,
17th ed. (Romeoville: LUWC Press, 2018), 19.

Bibliography Format: | Lastname, Firstname [first author], Firstname Lastname [second author], and
Firstname Lastname [last author]. Title of Book. City: Publisher, year.

= Example: = Doe, Lewis M., Melissa Lonero, and Taylor French, eds. CMS Reference Guide.
17th ed. London: UCL Press, 2018.

Chapter in an edited book/anthology

Footnote/Endnote Superscript. Firstname Lastname of chapter author, “ Title of Chapter,” in Title of
Format: Book, ed. Firstname Lastname of editor[s], (city: Publisher, year), page[s] cited.
= Example: = 3. Lewis M. Doe, “CMS Checklist,” in CMS Reference Guide, ed. Melissa Lonero

and Taylor French, (n.p.: LUWC Press, 2018), 158-60.

Bibliography Format: | Lastname, Firstname of chapter author. “Title of Chapter.” In Title of Book, edited by
Firstname Lastname of editor[s], chapter/page span. City: Publisher, year.

= Example: = Doe, Lewis M. “CMS Checklist.” In CMS Reference Guide, edited by Melissa
Lonero and Taylor French, 158-60. N.p.: LUWC Press, 2018.
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Citations in Footnotes/Endnotes and the Bibliography

Journal article with URL, incorporating DOI when possible

Footnote/Endnote Superscript. Firstname Lastname, “Title of Article,” Journal volume, no. issue
Format: (year): page[s] cited, URL/doi.
= Example: = 4. Lewis M. Doe, “CMS Checklist,” CMS Reference Guide 17, no. 2 (September

2018): 158-69. https://doi.org/10.1010/101010.

Bibliography Format: | Lastname, Firstname. “Title of Article.” Journal volume, no. issue (year): page span.
URL/doi.

= Example: = Doe, Lewis M. “CMS Checklist.” CMS Reference Guide 17, no. 2 (September
2018): 158-69. https://doi.org/10.1010/101010.

Magazine and newspaper

Footnote/Endnote Superscript. Firstname Lastname, “title of Article,” Column Title [if applicable],

Format: magazine or Newspaper Name (mobile app [if used]), Month year [or Month day,
year], section [if applicable], page[s] cited [if available], URL [when online version is
consulted.

= Example: = 5. Lewis M. Doe, “What is the Chicago Manual of Style? Here’s What You Should

Know,” The Flyer, August 9, 2018, sec. News, 2.

= Example: = 6. Lewis M. Doe, “What is the Chicago Manual of Style? Here’s What You Should
Know,” The Flyer (iPhone App), August 2018.

Bibliography Format: | Lastname, Firstname. “Title of Article.” Column Title [if applicable]. Newspaper or
Magazine Name (mobile app [if used]). Month day, year, section [if applicable],
page span [of available]. URL/doi.

= Example: = Doe, Lewis M. “What is the Chicago Manual of Style? Here’s What You Should
Know.” The Flyer. August 9, 2018, sec. News, 2.

= Example: = Doe, Lewis M. “What is the Chicago Manual of Style? Here’s What You Should
Know.” The Flyer (iPhone App), August 2018.

Website

Footnote/Endnote Superscript. Firstname Lastname [if applicable], “Title of Webpage,” Website

Format: publisher [if indicated], Month day, year [publication, modification, or access], URL.

= Example: = 9. “Writing Center,” Lewis University, accessed September 5, 2018, https://

www.lewisu.edu/resources/larc/writinglab.htm

*If the title ends with a question mark, you do not have to add a colon between the
title and subtitle.

Bibliography Format: | Lastname, Firstname [if applicable]. “Title of Webpage.” Website publisher [if
indicated], Month day, year [of publication, modification, or access]. URL.

= Example: = “Writing Center.” Lewis University. Accessed September 5, 2018. https://
www.lewisu.edu/resources/larc/writinglab.htm.
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Citations in Footnotes/Endnotes and the Bibliography

Encyclopedia or dictionary in print or online

Footnote/Endnote
Format:

= Example:

= Example:

Superscript. Encyclopedia Name, edition, s.v. “encyclopedia entry” [for online
source, add: posted date, revision date, or accessed Month day, year, URL.

= 7. Encyclopedia Britannica, 16th ed., s.v. “style.”

= 8. Oxford English Dictionary, 3rd ed., s.v. “style,” accessed September 5, 2018,
http://www.oed.com.

*s.v. is latin for sub verbo, meaning “under the word,” i.e. the information is found
under the word “style.”

Bibliography Format:

Encyclopedia and dictionary references are typically not included in CMS
bibliographies.

Government documents *Note that citations for legal works follow one of two guidelines, as
recommended by CMS: (1) The Bluebook: A Uniform System of Citation by Harvard Law Review
Association, or (2) the ALWD Guide to Legal Citation by the Association of Legal Writing Directors and
Coleen M. Barger. It is recommended that you take a look at these style guides for additional information.

Footnote/Endnote
Format:

= Example:

Superscript. Issuing Country, Government Division, Named Subsidiary Divisions,
Document Title, by Firstname Lastname [if available], Report Number or Name
(City: Publisher, year), page[s] cited [if applicable], URL.

= 10. California, Bureau of Investigation, Russian Organized Crime, by Dept. of
Justice, Division of Law Enforcement, (Sacramento, CA: California, 1996), http://
www.fas.org/irp/world/para/docs/rusorgi.htm.

Bibliography Format:

= Example:

Number. Issuing Country. Government Division. Named Subsidiary Divisions.
Document Title. Firstname Lastname [if available]. Report Number or Name.
City: Publisher, year. Page[s] cited [if applicable]. URL.

— California. Bureau of Investigation. Russian Organized Crime. Dept. of Justice,
Division of Law Enforcement. Sacramento, CA: California, 1996. http://
www.fas.org/irp/world/para/docs/rusorgi.htm.

Film
Footnote/Endnote Superscript. Firstname Lastname of content author [if critical commentary or
Format: other ancillary content], Title of Work, directed by Firstname Lastname, (year of

= Example:

studio release; city: Studio, year of physical copy), format [including URL if online],
length [for physical copy].

= 7. Dunkirk, directed by Christopher Nolan, (2017; USA: Warner Bros, 2017),
DVD, 109 min.

Bibliography Format:

= Example:

Lastname, Firstname of Director, dir. Title of Work. Year of studio release. City:
Studio, year of physical copy. Format [including URL if online], length [for
physical copy].

= Nolan, Christopher, dir. Dunkirk. 2017. USA: Warner Bros, 2017. DVD.
109 min.
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The Author-Date System

The Author-Date (AD) system of the Chicago Manual of Style makes use of parenthetical citations to provide
source information. For this system, you will document your sources in two places: within the text and your
references section at the end of your essay.

Parenthetical citations, also known as in-text citations, are located at the end of a sentence that paraphrases
or directly quotes information from a source. These types of citations include the last name(s) of the author(s)
and the year of publication enclosed in parenthesis. Page numbers are also included in the parenthetical if a
direct quote is being used. The general format when citing a source with one author is the following:

(Lastname year, page number) For example: (French 2018, 113)

When citing a source with two or three authors, their last names should be presented in the order in which
they are listed in the publication. The word “and” should be used between the last two names in a
parenthetical citation. For a source with four or more authors, the first time you cite the source in the paper,
you should only use the first author’s lase name followed by “et al.” and the year of publication

(Lastname1, Lastname2, and Lastname3 2018) For example: (French, LaLonde, and Lonero 2018)
(Lastnameil et al. 2018, 113) For example: (French et at. 2018, 113)

If you choose to integrate the name of the author within your sentence, you should provide the year of

publication in parenthesis next to it. For example:

According to French (2018), the Writing Center is a “resource for all Lewis University students” (113).

References

Your references should be located at the end of your paper, on a
new page. The top of the page should still include the page number | = 2% [nasncend mssbceor AaBbe: assvee AAB 4
and the word “References” should be included on the first line. The |—|
word should be centered, should not include quotation marks,and |~~~
it should not be bolded, italicized, or underlined.

Thormal | 7Ne Spaci.. Headingl Heading2 Title s

S. (2013). Library Use and [ Pmsen s S i i
B(2), 147-164. prr———
After the page title, leave two blank lines before your first citation. [
This section should not be double spaced, unlike the rest of your
paper, and you should include a blank line between each citation. T E |- )
Your citations should appear in alphabetical order and should be SO I
formatted with a hanging indent. You can include a handing indent .

by going to your “Paragraph” settings on Word.

For information on how to cite your source in the references section of your paper, please refer to the
“Bibliography” examples on the tables in pages 5-7 of this reference guide.

Sources Consulted: The Chicago Manual of Style (17th edition), Purdue OWL, University of
Manitoba, Boundless Writing.




